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Outline    HFSS Getting Started M03: Solution Setup 

• Simulation Solution Setup Auto
− Speed versus Accuracy
− Frequency Sweep Settings

• Simulation Solution Setup Advanced
− Driven Solution Setup
− Frequency Sweep

• HFSS Adaptive Meshing 
− Adaptive Meshing algorithm flow
− Frequency, Max # Passes,  and Delta S
− Specifying Delta S

• Accuracy and Resolution 
− Delta S & Maximum Number of Adaptive Passes 
− Sweep - density of data with frequency
− Solution Frequency

This shows the HFSS Solution Setup Auto option. 
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The HFSS Simulation Setup and Sweep in the Workflow

Geometric Structure
Materials

Simulation Results

Ports & Excitations

Boundaries
Simulation Space 

Mainly about mesh

Mainly about simulation 
sweep with frequency

Simulation Setup 
Adaptive Process

Simulation Setup -
Frequency Sweep

This shows the HFSS Solution Setup Advanced option. 
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Accessing the HFSS Driven Solution Setup Dialog Box 

From the Ribbon, HFSS Solution Setup can 
be accessed from the Simulation tab.  

From the Project Manager, HFSS Solution 
Setup can be accessed from Analysis > 
Add Solution Setup. 

The two choices for  
HFSS Solution Setup 
are Auto and 
Advanced.
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HFSS Auto Solution Setup - Meshing and Sweep 

Two aspects of HFSS solution 
process are the 

1. meshing … and the 

2. frequency sweep. 

In the HFSS Solution Setup Auto
option, both the meshing and the 
frequency sweep are specified on 
the General tab of the Driven 
Solution Setup dialog box.  

The choice of slider setting, 
trading off speed versus 
accuracy, specifies the HFSS 
meshing.  

Interpolating sweep type 
doesn't simulate every single 
point.  Discrete sweep does 
simulate every single point 
specified in the sweep.  For 
large numbers of frequency 
points, interpolating sweep 
will run much faster than 
discrete sweep. 

There are several Distributions.  
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HFSS Solution Setup Advanced

The HFSS Solution Setup Advanced option 
separates the meshing and the frequency 
sweep into two distinct parts.  
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HFSS Solution Setup Advanced Options Tab

With the HFSS Solution Setup Advanced
option, there are additional tabs in the 
Driven Solution Setup tab dialog box. 

The HFSS Solution Setup Advanced option 
accesses details and options for setting up 
the HFSS mesh. 
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Meshing Discretizes the Computational Volume for Simulation 

− Meshing discretizes the simulation space in an HFSS FEM (finite element method) simulation.

− The mesh is what actually gets simulated (not the CAD geometry).  

− The mesh is profoundly important to simulation accuracy and speed. 

− Creating a good mesh is very important. 

− HFSS has an automated, iterative way of creating the FEM mesh, called adaptive meshing. 

band pass filter mesh mesh with E-field overlay
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Adaptive Meshing Is an Automated Process for Mesh Creation  

Adaptive meshing is the automated process that HFSS 
uses to create and refine the FEM simulation mesh.  

From the document An Introduction to HFSS, Chapter 1 Fundamentals of HFSS section titled 
Adaptive Solution Process and its Importance to HFSS. 
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Adaptive Meshing Steps - Excerpts from HFSS Help  

Adaptive meshing is the automated
process that HFSS uses to create and 
refine the FEM simulation mesh.  

These text graphics come from the HFSS 
Help document An Introduction to HFSS, 
Chapter 1 Fundamentals of HFSS section 
titled Adaptive Solution Process and its 
Importance to HFSS. 
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HFSS FEM Automated Solution Adaptive Port Meshing Process 

Adaptive Port 
Refinement

Solve

Quantify Mesh 
Accuracy

Mesh Refinement

Frequency 
Sweep

YesNo
Max(|DS|)<goal?

Initial Mesh

Adaptive 
Mesh 
Creation

Geometry Initial Mesh Converged Mesh

Initial Mesh Refine Mesh Freq. Sweep

Electrical Mesh
Seeding/Lambda Refinement

Initial Mesh
Geometric Mesh

HFSS tunes the FEM 
mesh to accurately 

capture the device’s 
electrical performance.

The HFSS setting 
used in the 

decision diamond 
is called Delta S.  

Frequency Sweep
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Automatic Adaptive Meshing for HFSS FEM Simulation

− HFSS automatically generates a geometrically conforming, tetrahedral mesh.  
− HFSS's iterative meshing algorithm solves the fields of the model and intelligently refines the mesh 

until S-parameters converge below a user defined threshold, Maximum Delta S.
▪ The user defines frequency or frequencies at which adaptive meshing is performed. 
▪ After each solution, tetrahedral elements are “graded” for their accuracy to Maxwell's equations.
▪ User defines percentage of “bad” tetrahedral elements to be refined after each pass (30% Default).

Geometrically conforming 
tetrahedral mesh
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Driven Solution Setup - General Tab - Solution Frequency

The Solution Frequency sets:
• The frequency used to create the adaptive mesh

– Defines the spatial resolution of the mesh through the Lambda 
Refinement step

– Lambda Refinement is wavelength dependent
• Determines the frequency used to evaluate the mesh’s convergence
• Typically choose the highest frequency of interest or for resonant 

antennas, the resonant frequency

A higher frequency mesh is generally valid at lower frequencies
• A mesh created at a higher frequency will be denser than a mesh at 

lower a frequency because the wavelength is smaller
• The denser mesh is likely to pickup the field variations associated with 

lower frequencies behaviors

A low frequency mesh is generally NOT valid at higher frequencies
• A mesh created at a lower frequency will be coarser than a mesh 

created at a higher frequency because the wavelength is longer
• The coarser mesh is less likely to pickup field variations associated 

with the higher frequencies
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HFSS Solution Setup: Adaptive Meshing and Frequency Sweep

Adaptive Port 
Refinement

Solve

Quantify Mesh 
Accuracy

Mesh Refinement

Frequency Sweep
YesNo

Max(|DS|)<goal?

Adaptive Mesh 
Creation

Electrical Mesh
Seeding/Lambda Refinement

Initial Mesh
Geometric Mesh

HFSS adaptive mesh 
settings are:  

1. Frequency

2. Maximum 
Number of Passes

3. Maximum Delta S  

S-parameter resolution comes from 

frequency sweep settings.
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Converging on Maximum Delta S in HFSS Adaptive Meshing 

• Delta S Summarizes the S-Parameter’s sensitivity to change in mesh

• A single number characterizing mesh sensitivity for the entire S-Matrix 
• Accounts for magnitude and phase variation between meshes of all S-

parameters simultaneously.
• Default value of 0.02 is reasonable for most cases
• Reports the worst-case violation.

• DON’T over-specify
• Setting the Maximum Delta S too small wastes computer resources and 

time.

• DON’T under-specify
• Setting the Maximum Delta S too large jeopardizes accuracy.

    1−−=D NN SSMaxSMax

The document An Introduction to HFSS, Chapter 1 Fundamentals of HFSS section 
Mathematical Method Used in HFSS gives a good technical description of the HFSS 
finite element solution process touching Green's functions and Maxwell's equations.  
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HFSS goes from adaptive 
meshing to frequency 
sweep in both/two  cases: 

1. Convergence is reached 
(before the Maximum 
Number of Passes is 
reached) 

OR
2. Maximum Number of 

Passes is reached, but 
convergence has not 
been reached.  

Pay attention to the 
Message Manager at the 
bottom of the HFSS GUI as 
well as the Profile dialog 
box available by right-
clicking on Setup in the 
Project Manager. 
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Broadband and Multi-Frequency Adaptive Meshing 

In addition to Single frequency 
meshing, HFSS offers Broadband
and Multi-Frequencies meshing. 

From the HFSS Online 
Help document 
HFSS.pdf, Chapter 19 
Specifying Solution 
Settings section titled 
Broadband Frequency. 
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Additional HFSS FEM Learning and Reference Resources

For additional background on the finite element method (FEM) that HFSS uses for simulation, and closely 
related topics like boundaries, study the course HFSS 3D Components, Boundary Conditions, Ports and Mesh. 

There are also several resources that come with HFSS.  

In the HFSS install directories, such as AnsysEM…\Help\HFSS
there is an HFSS help document HFSS.pdf which includes sections: 
20 - Assigning Boundaries in HFSS and HFSS-IE
30 - Meshing In HFSS
This chapter on meshing describes the tetrahedra used in HFSS FEM meshing
31 – Technical Notes 
This chapter has a section “HFSS Technical Notes” that discusses FEM, including size of mesh versus accuracy. 

And in the HFSS online Help there is a file:
An Introduction to HFSS.pdf.  These are in the install directories. 
This document discusses boundaries and adaptive meshing.
Chapter 5 HFSS Modeling GUI Basics includes a section called 
Modeling Practice in HFSS which shows an HFSS  workflow. 
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Driven Solution Setup Specifies the HFSS FEM Meshing

Solution Setup Specifies the HFSS Mesh
• Frequency
• Maximum Number of Passes
• Maximum Delta S. Three ways to bring up the Driven Solution Setup dialog box for 

setting HFSS mesh specifications using the Advanced Option.   

Right-click 
on Analysis 

1.

2.

3.

The document An Introduction to HFSS, Chapter 4 HFSS Solution Setup includes a section Driven Solution Setup with more information. 

A primary way to 
set accuracy in 
HFSS simulations  

HFSS > Analysis Setup > 
Add Solution Setup
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Simulation Sweep Dialog - Edit Frequency Sweep

Three ways to bring up the Edit Frequency Sweep 
dialog box for specifying an HFSS frequency sweep.    

Right-click 
on Analysis 

1.

2.

3.

A Setup (from Analysis) must be 
selected in order for Sweep to become 
available (not greyed out). (HFSS 
Solution Setup Advanced Option) 

HFSS > Analysis Setup > 
Add Frequency Sweep
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Edit Frequency Sweep - Three Types of Frequency Steps 

Three Sweep Types in HFSS 

1. Interpolating
Good for wideband - no fields  

2. Discrete 
Generates fields at every frequency.  Can 
also save fields. 

3. Fast - (ALPS) - Use with caution 
Recommended only for the very narrow 
frequency sweeps when field information 
is necessary for many frequency points.

The document An Introduction to HFSS, Chapter 4 HFSS Solution Setup includes a section Frequency Sweeps with more information. 

Linear Count
Total number of frequencies, spread over the whole 
frequency range

Linear Step 
Frequency between steps 
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Three Ways to Start an HFSS FEM Simulation - Analyze

Three ways to start an HFSS simulation

Right-click 
on Analysis 

1.

2.

3.

Validation is an important and useful check before 
starting an HFSS simulation. 

HFSS > Analyze All

Validate 
before 

simulation 
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HFSS Solution Type - Driven Modal versus Driven Terminal  

Solution types are a 
fundamental part of 
every HFSS simulation.  

Among all the possible HFSS 
Solution Types, this course, 
focusing on frequency domain, 
looks at Modal and Terminal. 

From the document "An Introduction to HFSS", Chapter 1 
"Fundamentals of HFSS" section titled "Solution Types". 
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HFSS Solution Type - Driven Modal versus Driven Terminal  

Access the HFSS 
Solution Type dialog 
box with HFSS > 
Solution Type.  
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Driven Modal versus Driven Terminal Solution Type S-Parameters

From the document "An Introduction to HFSS", Chapter 1 
"Fundamentals of HFSS" section titled "Solution Types". 

Modal versus 
terminal solution 
types will be 
revisited in the 
study of HFSS 
lumped and wave 
port setups. 
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HFSS Default Solution Types Under Tools > Options

The HFSS Solution Type gets set by default for new projects.  
Access this Options dialog box from the Ribbon, in the 
Desktop tab, with General Options.  

Another way to access this dialog box with Tools > Options > General Options.  



End of Presentation


